
File menu commands

The File menu offers the following commands:

Add Files Brings up the Add Files panel.
Stored Commands Brings up the Stored Commands panel.
Auto Select Runs the auto-selector for the currently selected files.
Exclude Excludes the currently selected files.
Rename Single 
File

Renames a single file.

Rename Renames all the files in the file list.
Undo Rename Undoes the last rename operation.
Recent Folders This submenu contains the most recently selected folders.
Exit Exits RenameMan.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



View menu commands

The View menu offers the following commands:

Show File Size Adds/removes the File Size column from the file list.
Show Modified 
Time

Adds/removes the File Modified Time column from the file list.

Options Brings up the Options panel.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get 
help.

What’s this? Provides context sensitive help.
About Displays the version number of this application.



Status Bar

The status bar is displayed at the bottom of the RenameMan window.

The status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    If after viewing the description of a menu command you wish not to 
execute the command, then release the mouse button while the pointer is off the menu.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

The title bar may contains the following elements:
Application Control-menu button
Maximize button
Minimize button
Name of the application
Restore button



Scroll bars

Displayed at the right and bottom edges of the panels in the window when the contents 
become too large to view in their entirety.    The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document.    You can use the mouse to scroll to 
other parts of the view.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the RenameMan window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    RenameMan determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    RenameMan 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the RenameMan application or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



What does RenameMan do?

RenameMan is a tool that allows you quickly and easily to rename lots of files at once.    It is 
an extremely flexible tool, and in particular has special support for handling files with a 
number embedded in the name.

Features
    Extremely flexible and easy to use
    Shows how all the files will be renamed before any are changed on disk
    Fail safe, any problems (such as trying to rename two files to the same name) are 

prevented
    Special support for filenames with embedded numbers
    Automatically finds wild card pattern to match filenames
    Auto number facility makes it easy to create numbered sequences
    Command store for your most common rename operations
    Undo last rename command

For a quick introduction to RenameMan, take a look at this quick tour.



System requirements

RenameMan requires:
Windows 95/98/Me, or
Windows NT 4.0, or
Windows 2000, or later.

1 Mbyte disk space.



Quick tour of RenameMan

The application window is divided into two halves.    The left-hand pane contains the folder 
browser, which is where you select the folder that contains the files to be renamed.    The 
right-hand pane contains the file list, plus all the controls to rename the files.

You can adjust the size of the two halves by dragging the bar that separates them.

The selector allows you to select which files in the current folder are to be renamed.    These 
are shown in the file list, which also shows the new name for each file.

Finally, the bottom of the right-hand pane is where the rename command is set.    The 
rename boxes allow you to set how each part of the name is changed.    All changes to the 
rename commands are immediately reflected in the file list.    Once the rename commands 
have been set, the files can all be renamed by hitting the rename button.



Contact ExtraBit Software

If you have any further questions regarding RenameMan, or if you have any suggestions or 
bug reports, please send email to support@extrabit.com.



Selecting the files to rename

When you click on a folder in the folder browser, all the files from that folder are added to 
the file list.    However, only those files that match the pattern in the selector are shown.    As 
the selector is changed, the files shown in the file list are updated.    To show all the files that
have been added to the file list, press the reset button, which resets the selector to *.

For more control over the way files are added to the file list, including being able to add files 
from subfolders of the selected folder, use the add files command.

Files can also be excluded from the file list using the exclude command.    Once a file has 
been excluded from the file list, the only way to bring it back is to select the folder in the 
folder browser again.



The folder browser

The folder browser is where the folder containing the files to be renamed is selected.    It 
works the same way as the folder browser in Windows Explorer.    Select a folder by clicking 
on its name.    This will automatically add all the files in the selected folder to the file list.    To
expand a folder to see the subfolders it contains, either click on the + next to the name, or 
double click the name.

If the file list does not show all the files that are in the current folder, this may be due to 
either the selector being set to something other than *, or it could be that some files in the 
file list have been excluded.

You can also right click on a folder to bring up the folder context menu.    This menu just has 
the add files command on it.    This command allows you to choose the files to add to the file 
list rather than simply adding all the files in the selected folder.

If the files in a folder are changed outside of RenameMan, you must select the folder again 
in the folder browser to update the file list.    This is the only time that the folder is read to 
get a list of the files it contains.    Selecting a folder also brings back any files that have been 
excluded.    This is the only way to bring a file back into the file list once it has been 
excluded.



The file list

The file list shows all the files that have been selected for renaming.    It shows the existing 
name in the column titled "Old Name", and the new name in the column titled "New Name".  

If files have been added from subfolders by using the add files panel, then there will also be 
a "Folder" column.    This shows the folder path of each file, relative to the currently selected 
folder in the folder browser.

The column options panel allows extra columns showing the file size and file last modified 
time to be added.    These columns are useful since they allow you to sort the file list based 
on the file size or file last modified time, which can be used to auto-number the files based 
on these attributes.    Another way to show or hide these columns is to right click in the 
column header and using the file list column context menu.

To sort the file list on any column, click in the column header.    To reverse the sort order, 
click a second time in the sort column header.    The sort column can be identified since it 
contains a small triangle in the header.    This points up if the sort order is ascending, or 
down if the sort order is descending.

To resize the width of the columns, drag the right edge of the header at the top of each 
column.

Each name may have one of the following symbols next to it, to indicate that there is a 
problem with the current rename command.    You will not be able to rename the files until all
these problems are fixed.

    Indicates that the new name is the same name as an existing file.    This can happen 
either because the existing file is not selected to be renamed, or if two or more files are 
being renamed in such a way that a cyclic dependency exists between them.

    Indicates that the new name is the same as the new name of one of the other files being
renamed.

    Indicates that the new name is empty.    All filenames must have at least one character 
in them.

Right click in the file list to bring up the file list context menu.    This menu provides 



commands to allow you to auto-select based on the selected files, exclude one or more files 
from the file list, or to quickly rename a single file.



The selector

The selector serves two purposes:

1.    Selecting files for renaming
The selector can be used to select a subset of the files in the current folder for renaming.    
This is done by entering a pattern that is matched against all filenames in the current folder. 

Each filename in the current folder is tested against the pattern, and if it matches it is added
to the file list.    Note: the case (upper or lower) of letters is ignored when comparing 
filenames with the pattern.    This is because Windows itself ignores the case when searching
for files.

For example, *abc* will match any filename that contains abc somewhere in the name.    
*.??? will match any filename that has a 3 character extension.    *#* will match any 
filename that contains an embedded number, provided the treat numbers as text switch is 
off.

2.    Setting the parts breakdown
The second use of the selector is to set how the filenames are broken down into parts for 
renaming.    The parts are generated by combining adjacent * and ? wild cards into a single 
wild part, and adjacent text characters into a text part.    Any # wild cards are turned into a 
number part.    Finally, if any wild or number parts are not followed by a text part, then a 
blank text part is added so that text can be added at those points in the names.

For example *abc* will be turned into the parts: [empty text], [wild card], ["abc"], [wild 
card], [empty text]. 

In order to have full control over the way the selector is broken down into the different parts,
the / character can also be used to force a break.    This is used between wild cards that 
would normally be combined into a single part, which would mean only a single command 
could be applied to that part.    For example, the selector ?* will match any filename that has
one or more characters.    However, only one wild part will be generated.    If you wanted to 
apply a command to the first character only, it would not be possible.    If instead you use the
selector ?/* this will still match any filename that has one or more characters, but two wild 
text boxes will be generated.    The first will be for the first character matched by the ? wild 
card, and the second will be for the rest of the filename matched by the * wild card.    This 
would allow, for example, an operation to capitalize the first letter of a filename to be 



defined.

Automatically setting the selector
The auto-select function can be used to automatically set the selector to the best pattern for
renaming the auto-selected files.



The rename boxes

This area of the window is where the rename information is entered.    The filenames are 
broken into parts, each of which has a pair of boxes showing how that part of the filename 
will be changed.    The way the filename is broken down into parts is controlled by the 
selector.

    Literal text changes
    Wild text changes
    Number changes

Right clicking in any of the rename boxes brings up the context menu for that rename part.

    Clear command - sets the rename part so that any text in that part of the filename is 
cleared.
    Reset command - sets the rename part so that it leaves the text in that part of the 

filename unchanged.



Storing commands

RenameMan allows you to store any rename command for re-use later.    You can add or 
remove commands at any time by using the stored commands panel.    Stored commands 
are automatically saved so that they are available the next time you run RenameMan.

To use a stored command, simply select it in the stored commands list.    This sets the 
rename options (allow file extension changes and treat numbers as text), the selector, and 
the rename commands to the state they were in when the selected command was stored.    
You can then either simply press the rename button to rename the currently selected files, 
or modify the rename command before renaming the files.



Changing part of the name all files have in common

This section describes how to rename a set of files that all have a part of their name in 
common, and how to insert text into the filenames.

First select the files you want to rename.    You then need to enter the pattern in the selector 
that will select all the files that have the common part you want to change. If all the files in 
the file list have the common part you want to change, then you can use the auto-selector to
save having to type the pattern.

At this stage, you will have several pairs of boxes at the bottom of the right hand pane.    
One of these pairs of boxes will have the common part of the name that you want to change.
Click in the lower of the pair of boxes that contains this, and you will get the text change 
panel.    Enter the new text you want for this part of the file names, and press "OK".

If you want to insert text into the name, this can be done by using the text change panel for 
any of the empty boxes.    Empty boxes are automatically added to allow text to be inserted 
at any point in the filenames.

You will now see in the "New Name" column of the file list, the new names for all the files.    If
these are the names you want, press the rename button to rename all the files.



Changing part of the name that is not the same for all files

This section describes how you can make changes to part of the filenames that is not the 
same for all files.    These parts of the filename are those matched by the * wildcard pattern.  
The changes that can be made to this part of the filename are:

    changing the case of letters to upper or lower case
    removing spaces
    shortening (truncating)

First select the files you want to rename. For example, if you want to make all filenames 
upper case, then enter * in the selector.    This will mean you will only get one wild card 
rename box.    Also note that if the allow file extension changes box is not checked, then no 
changes can be made to the filenames’ extensions.

Click in the lower of the pair of boxes with the wild card symbol * in it, and you will get the 
wild card panel.    Select the options you required, and press "OK".

You may find at this point that some files have a  symbol next to them in the file list.    For 
example, this can happen if you have used the "truncate" option to shorten parts of the 
filenames.    This indicates that two or more files have been renamed to the same name.    
You will need to correct this before you can rename all the files, by either excluding or 
individually renaming one or more files.

You will now see in the "New Name" column of the file list, the new names for all the files.    If
these are the names you want, press the rename button to rename all the files.



Changing numbers in filenames

This section describes how to make changes to numbers in filenames.    The changes that 
can be made to a number are:

    Adding or removing leading zeros
    Adding or subtracting a constant value

Adding leading zeros to numbers in filenames can be extremely useful, since it means that 
when the files are listed in a browser, they will be listed in numerical order.    For example, 
without leading zeros, files named 1 to 12 would be listed in the following order: 1, 10, 11, 
12, 2, 3, 4, 5, 6, 7, 8, 9.    Adding leading zeros means that they will be listed in numerical 
order: 01, 02, 03, 04, 05, 06, 07, 08, 09, 10, 11, 12.

To change numbers in the filenames, first make sure the treat numbers as text box is not 
checked. Next, select the files you want to rename.    If all the files in the current folder 
contain numbers, then you can use the auto-selector to set the selector. Otherwise, you can 
use *#* in the selector, which will match any filename containing a number.

Click in the lower of the number rename pair of boxes, and you will get the number panel.    
Select the options you require, and press "OK".

You will now see in the "New Name" column of the file list, the new names for all the files.    If
these are the names you want, press the rename button to rename all the files.



Stored Commands list

The Stored Commands list allows stored commands to be selected.    Selecting inside the list 
box will pop up the list of stored commands.    Select the one you want, and it will be made 
the current command.

The commands listed in the Stored Commands list are controlled from the stored commands 
panel.



Store button

The Store button brings up the stored commands panel.    This panel can also be brought up 
by using the stored commands command.



Allow File Extension Changes switch

This switch sets whether changes to file extensions are allowed.    The file extension is all 
characters after the ‘.’ in the filename.    This is usually used to determine what type of data 
the file contains, so you should not normally change this.    One consequence of changing a 
file’s extension is that it will no longer be automatically associated with the application that 
can open it.

If this switch is off, then RenameMan will not allow the file extension to be changed.    You 
can still use an extension in the selector, but this will only be used to select files with a 
particular extension.    The rename boxes will not include the extension.

If this switch is on, then you will be able to change the extensions of the files.    This does not
necessarily mean the extension will be changed, since the rename command may not affect 
that part of the filenames.    You should only change the extensions of files if you know what 
you are doing.



Treat Numbers As Text switch

This switch turns on or off the special support for numbers in filenames.    When this switch is
on, numbers are treated no differently to any other text.    When it is turned off, then 
numbers in filenames can be changed using the number panel.    Numbers in the filenames 
can be found by using the symbol # to match any number in the selector.

Note: numbers embedded in filenames are assumed to be decimal integers.    Also, negative 
numbers are not supported.



Reset Selector button

The Reset Selector button resets the selector pattern back to *, and removes any rename 
commands that may have been entered in the rename boxes.

However, it does not bring excluded files back into the file list.    The only way to do that is to
select the current folder again in the folder browser.



Auto Select All button

The Auto Select All button runs the auto-select function on all the files in the file list.    This 
operation is automatically run if the option to auto-select all when folder selected is enabled.



Rename button

The Rename button renames the physical files on the disk.    Until this button is pressed, no 
files on the disk will be altered in any way.

The files are renamed to the new names shown in the file list.

After the all the files have been renamed, the file list is refreshed to show the new names.    
Note, however, that the selector is not changed by this command, so if the new names no 
longer match the pattern in the selector, they will disappear from the file list.    Press the 
reset button to set the selector back to *, which will match all files.



Auto selecting files

A very common case when renaming lots of files is that you want to change a certain text 
string that all the filenames have in common.    For example, all files may start with abc, and
you may want to change this to xyz.    In order to do this, you would need to enter abc* in 
the selector, which would set up a text box in the rename boxes which would allow you to 
change the abc prefix.

However, it is possible to set the selector automatically using the auto-select function.    This 
automatically finds all parts of the filenames that all the files in the file list have in common. 
For example, if all files do start with abc, then the selector will be set to abc*.

There are two ways to use the auto-select function.    The simplest way is to press the auto 
select all button.    This is useful if all the files in the file list have the common parts you want
to match.    Note that if the option to auto-select all when folder selected is enabled, then the
auto-selector will automatically be run for all files when the files are added to the file list.

If only some of the files in the file list have the common parts you want to match, then it is 
best to select some of the files that have the common parts, and then right click the 
selection and use the auto-select command on the context menu.    This can be especially 
useful if you want to select files that have the same name except for a changing number, 
since you only need to select one of the files and use the auto-select command (providing 
the treat numbers as text switch is off).



Pattern matching

A pattern consists of a combination of text and special "wild" characters.    The wild 
characters can match a range of characters in the filenames, and so allow several filenames 
to be matched at once.    The wild characters supported are:

*    Matches any character, and any number of characters.
?    Matches any single character.
#    If the treat numbers as text option is off, matches any decimal integer, i.e. any 

string of adjacent characters which are all in the range '0' to '9'.



Cyclic dependency rename problem

This occurs when two or more files are being renamed to the same name as each other in a 
loop.    For example, suppose you start with two files called 000.txt and 001.txt, and set up 
a rename command such that 000.txt is renamed to 001.txt, and 001.txt is renamed to 
000.txt. Both of these files will be flagged with the  warning in the file list, since neither 
can be renamed without overwriting the other.    The same problem can occur with more 
than two files if they are renamed to each other in a loop.

The solution is to break the loop by renaming one of the files to a name that is different to all
the other files.    This will allow all the files to be renamed.



How to buy

To buy RenameMan costs just $15.    To order, simply go to our website at 
http://www.extrabit.com/renameman and click on "Order RenameMan". 
{button Open Web Page Now,EF(`www.extrabit.com/renameman/index.html',`',1)}

From there, you will be able to enter your credit card details and order online.

It is also possible to order by phone, fax, purchase order, or mail.    You still need to go to the 
website and click on "Order RenameMan", but instead of selecting the option to enter your 
credit card, pick the option you would prefer.

When you order RenameMan, you will receive a registration code that you will need to enter 
into the registration panel.

If you have any questions about ordering RenameMan, send an email message to 
"info@extrabit.com". 

Quantity discounts

If you order more than 1 license at the same time, you qualify for the following quantity 
discounts:

1st license $15
2nd - 9th licenses $10 each
10th and above license $5 each

The following table shows how this works:

No. of licenses Total cost
1 $15
2 $25
3 $35
4 $45
5 $55
6 $65
7 $75
8 $85
9 $95
10 $100
More than 10 Add $5 for each additional 

license

END-USER LICENSE AGREEMENT FOR RENAMEMAN

License Agreement

You should carefully read the following terms and conditions before using this software.    
Your use of this software indicates your acceptance of this license agreement and warranty.

Evaluation and Registration

This is not free software.    Subject to the terms below, you are hereby licensed to use this 
software for evaluation purposes without charge for a period of 30 days.    If you use this 
software after the 30 day evaluation period a registration fee of $15 is required.    The 



software can be ordered as described in the section "How to buy".    When payment has been
received you will be given a registration code that can be used to register your copy of 
RenameMan.

Distribution

You may make as many copies of this software and documentation as you wish.    You may 
freely distribute this software by any means provided that you include all files in the original 
distribution.

You are expressly forbidden from distributing by any means the registration code.

Registered Version

One registered copy of RenameMan may either be used by a single person who uses the 
software personally on one or more computers, or installed on a single workstation used 
non-simultaneously by multiple people, but not both.

You may access the registered version of RenameMan through a network provided that you 
have obtained individual licenses for the software covering all workstations that will access 
the software through the network.    For instance, if ten different workstations will access 
RenameMan on the network, each workstation must have its own RenameMan license 
regardless of whether they use RenameMan at different times or concurrently.

Governing Law

This agreement shall be governed by the laws of England.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. ANY LIABILITY OF THE SELLER WILL BE LIMITED 
EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.

RenameMan Copyright © 1998-2001 by Mark Williams. All rights reserved.





Add Files command (File menu)

This command brings up the add files panel.    This command is available in the File menu, or
by right clicking a folder in the folder browser, which brings up the following pop-up menu:

The add files panel gives you full control over the files to be added to the file list for 
renaming.    Whenever a folder is selected in the folder browser, any files in the file list are 
replaced by the files in the selected folder.    The Add Files command is only needed if you 
want more control over the files that are added, such as adding files from subfolders as well 
as the selected folder, or only adding only a subset of the files in the selected folder.

Shortcut
Keys: ALT, F, A



Stored Commands command (File menu)

This command brings up the stored commands panel.    This is used to manage the stored 
commands.    Stored commands can be added, removed, renamed and reordered.

This command is the same as pressing the store button.

Shortcut
Keys: ALT, F, C



Auto Select command (File menu)

This command runs the auto-selector for the selected files. This command is available in the 
File menu, or by right clicking on a file in the file list which brings up the following pop-up 
menu:

If no files are selected, the selector is not changed.



Exclude command (File menu)

Use this command to exclude the selected files from the file list.    This command is available
in the File menu, or by right clicking on a file in the file list which brings up the following pop-
up menu:

The exclude command provides a way of modifying the list of files that will be renamed.    
This can be used to exclude files that are still matched by the selector, but which you do not 
want included in the rename operation.

To exclude several files in one go, first select several files in the file list.      This is done by 
holding down the SHIFT key while clicking on a file to select a range, or holding down the 
CONTROL key while clicking on another file to add files to the selection one by one.    Right 
click on the selection and you will get a pop-up menu with only the exclude command in it, 
which you can use to exclude all the selected files.

Once files have been excluded from the file list, the only way to bring them back is to re-
select the current folder in the folder browser.

Shortcut
Keys: ALT, F, E



Rename Single File command (File menu)

This command brings up the rename file panel, which is used to rename a single file.    This 
command is available in the File menu, or by right clicking on a file in the file list, which 
brings up the following pop-up menu:

This command can be used to quickly rename just the selected file.    This can be useful if 
you find you want to rename just one or two files in a folder in a different way to all the 
others.    In this case, it is quickest to simply right click the file in the file list and choose the 
Rename Single File command.

If more than one file is selected, then this command will rename just the last selected file.

Once a file is successfully renamed using this command, it will then be automatically 
excluded from the file list, so don't worry that the file disappears from the file list after it has 
been renamed.

Shortcut
Keys: ALT, F, R



Rename command (File menu)

This command renames all the files in the file list to the new names shown.    This is the 
same as pressing the rename button.

You can use the undo rename command to restore the files to their original names.

Shortcut
Keys: F5



Undo Rename command (File menu)

This command renames the files that were renamed by the most recent rename command 
back to their original names.

Shortcut
Keys: ALT, F, U



Recent Folders (File menu)

The Recent Folders submenu contains the most recently selected folders.    Each time a 
folder is selected, it is added to the top of the Recent Folders submenu.    The number of 
folders kept in the Recent Folders submenu can be controlled using the options panel.

Selecting a folder from the Recent Folders submenu selects that folder in the folder browser.



Exit command (File menu)

Use this command to end your RenameMan session.    You can also use the Close command 
on the application Control menu. 

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.    This undo command is only
for undoing changes made to text in text boxes.    If you want to undo the last rename 
command, use the undo rename command instead.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected text from a text box and put it on the 
clipboard.    This command is unavailable if there is no text currently selected.

Cutting text to the clipboard replaces the contents previously stored there.

Note: this command is only for cutting text that is selected in a text edit box, it can not be 
used to cut files or folders.

Shortcut
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected text onto the clipboard.    This command is unavailable if 
there is no text currently selected.

Copying text to the clipboard replaces the contents previously stored there.

Note: this command is only for copying text that is selected in a text edit box, it can not be 
used to copy files or folders.

Shortcut
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point in the 
currently selected text edit box.    This command is unavailable if the clipboard is empty.

Shortcut
Keys: CTRL+V



Show File Size command (View menu)

This command is used to show or hide the File Size column in the file list.    If the File Size 
column is shown, this menu item will have a check mark next to it.    The main reason for 
wanting the File Size column to be shown in the file list is that it allows you to sort the files in
the files list by size.    This is done by clicking on the File Size column header.    When the files
are sorted by file size, this allows the files to be auto numbered based on the file size.

Shortcut
Keys: ALT, V, S



Show Modified Time command (View menu)

This command is used to show or hide the Modified column in the file list.    If the Modified 
column is shown, this menu item will have a check mark next to it.    The main reason for 
wanting the Modified column to be shown in the file list is that it allows you to sort the files 
in the files list by modification time.    This is done by clicking on the Modified column header.
When the files are sorted by file modification time, this allows the files to be auto numbered 
based on the file modification time.

Shortcut
Keys: ALT, V, T



View Options command (View menu)

This command brings up the options panel.

Shortcut
Keys: ALT, V, O



Help command (Help menu)

Opens the help window, showing the contents.

To get context sensitive help on the currently selected object, press F1.

Shortcut
Keys: ALT, H, H



Context Help command 

Use the Context Help command to obtain help on some portion of RenameMan.    When you 
choose the "What's This?" menu command, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the RenameMan window, such as another menu.    
The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
RenameMan.

Shortcut
Keys: ALT, H, A



Clear command (Rename box pop-up menu)

The Clear command sets the part of the filename controlled by the selected rename box to 
be clear.    For the different types of rename boxes, the Clear command does the following:

    For a text rename box, sets the “To” name to be empty text.
    For a number rename box, checks the “Clear number” option.
    For a wild rename box, checks the “Truncate” option, and sets the length to zero.



Reset command (Rename box pop-up menu)

The Reset command sets the part of the filename controlled by the selected rename box so 
that it is unchanged.





Add Files panel

This panel is brought up by using the add files command.    It replaces files in the file list with
files that are added from the folder currently selected in the folder browser.    This panel is 
provided to give greater control over the files that are added to the file list rather than 
simply adding all files in the selected folder, which is the default action when a folder is 
selected.    

The panel allows the files added to be controlled in the following way:

Adding files from subfolders

If the "Add files from subfolders" checkbox is checked, then files will be added from the 
selected folder, and also from all subfolders in the selected folder.    If the "Limit depth" 
check box is also checked, then only subfolders up to the given depth are searched.    A 
depth of 0 means the selected folder only, a depth of 1 means the selected folder plus the 
files in its subfolders, and so on.

Only adding files that match a pattern

If the "Only include files that match" checkbox is checked, then only files that match the 
given pattern will be added to the file list.    For files that do not match, it will be exactly as if 
they had been excluded from the file list.    This option is useful to avoid adding too many 
files to the file list, which may make RenameMan run very slowly.    For example, if you 
wanted to rename all files on your hard disk that ended in ".tiff" to ".tif", rather than adding
all files on the hard disk to the file list and then using the selector to select just the ones 
ending in ".tiff", it would be much quicker to only add the files that match "*.tiff" in the first
place.

Only adding files that do not match a pattern

If the "Exclude files that match" checkbox is checked, then only files that do not match the 
given pattern will be added to the file list.



If both the "Only include files that match" and the "Exclude files that match" options are 
selected, then a file must both match the include pattern, and not match the exclude 
pattern to be added to the file list.



Check this box if you want to add files from subfolders of the selected folder.



Check this box if you want to limit how far down to go in the subfolder hierarchy when 
adding files.    For example, if the depth is limited to 1, then only files in the selected folder 
and the immediate subfolders of the selected folder will be added.    This box is only enabled 
if the "Add files from subfolders box" is checked.



Enter the limit in this box of how far to go in the subfolder hierarchy when adding files.    This
box is only enabled if the "Limit depth" box is checked.



Click on these up and down buttons to increase or decrease the value in the depth limit box. 
These buttons are only enabled if the "Limit depth" box is checked.



Check this box if you want to only add files that match the given pattern.    Any files that do 
not match this pattern will be excluded.



Enter the pattern to check files with before they are added.    Any file not matching the 
pattern will be excluded.



Check this box if you want to exclude files that match the given pattern.    Any files that 
match this pattern will be excluded.



Enter the pattern to check files with before they are added.    Any file matching the pattern 
will be excluded.



Stored Commands panel

This panel is brought up using the stored commands command, or by pressing the store 
button.    This panel provides control over the stored commands.    Commands can be re-
ordered, added, deleted or renamed.    After the desired changes have been made, press the 
OK button.    If you change your mind about the changes you have made, pressing Cancel 
will close the panel and lose all the changes that were made.

The following actions can be performed using this panel:

Load stored commands list

The Load Stored Commands button allows a file containing a set of stored commands to be 
loaded.    These files can be created using the Save Stored Commands button.    Any stored 
commands already in the list are replaced by those loaded from the file.    Note that 
RenameMan automatically remembers the current stored commands list so it is not 
necessary to reload the list from a file every time RenameMan is run.

Save stored commands list

The Save Stored Commands button stores the current list of stored commands to a file.    
Stored commands are stored in a file with a ".cmds" extension. 

Move stored command up/down the list

 

These commands allow the list of stored commands to be re-ordered.    First, select a stored 
command in the list, then press the Move Up or Move Down buttons to move it up or down 
the list.

Delete stored command



This command allows a stored command to be deleted.    Select a stored command in the 
list, and press the Delete button.

Change stored command name

This command allows the name of a stored command to be changed.    The name of a stored 
command is what is shown in the stored commands list.    Select a stored command in the 
list, then press the Change Name button.    This brings up the change command name panel 
that allows you to change the name of the stored command.

Add stored command

This command allows a new rename command to be added to the stored commands list.    
The rename command added is the one that is currently set up in the rename boxes.    The 
rename command must be set up before the Stored Commands panel is brought up, 
although you do not have to rename any files in order to add the current command.

When the Add Command button is pressed, the add command panel is brought up.    Enter 
the name that you want for the new command.    This is the name that will be used in the 
stored commands list.



Shows the current list of stored commands.    Select a command by clicking on it in this list. 



Loads a set of stored commands from a ".cmds" file.



Saves the current set of stored commands to a file.



Moves the currently selected command up the list.



Moves the currently selected command down the list.



Deletes the currently selected command.



Brings up a panel that allows the name of the currently selected command to be changed.



Adds the current command to the list of stored commands.



Add Command panel

This panel is brought up by pressing the Add button on the stored commands panel.

Enter the name that you want for the new command, and press "OK".    The name will be the 
name shown in the stored commands list, so make sure it is descriptive enough that you will 
be able to remember what it does.



Change Command Name panel

This panel is brought up by pressing the Name button on the stored commands panel.

Enter the new name that you want for the selected command, and press "OK".    



Rename Single File panel

This panel is brought up by using the rename single file command.

This allows a single file to be quickly renamed.    Enter the new name in the "To" field and 
press "OK". 

After the file is renamed, it is excluded from the file list.    To bring it back into the file list, 
select the current folder again in the folder browser.



Shows the current filename for the file that is about to be renamed.    This field is read only.



Enter the new name for the file in this field.



Registration panel

To bring up the registration panel, go to the Help menu, then select About RenameMan.    
This brings up the About box.    If you are running an unregistered version of RenameMan, 
then this panel will have a Register button on it to bring up the registration panel.

When you order RenameMan, you will be given a registration code.    Once you have entered 
this code into the registration panel, your copy of RenameMan will be registered.    This 
means that when you start RenameMan, you will no longer get the panel telling you how 
many evaluation days you have left, and RenameMan will never expire.



Change Text panel

Text that is common to all filenames is shown in the change text boxes like this:

It may also appear like this when empty text boxes are added to allow text to be inserted 
into filenames between wild cards:

The change text panel is brought up by clicking in the change text box.

This panel simply allows new text to be entered which will replace the old text.    If the 
"Leave Unchanged" switch is checked, then the original text is left unchanged.    If any new 
text is entered, the "Leave Unchanged" switch is automatically unchecked.    The reason for 
having the "Leave Unchanged" switch is that although the original text in this part of the 
name will always be equal to the text shown in the "From" field, different filenames may 
have letters differently in upper case or lower case.    If the "Leave Unchanged" switch is 
checked, the original case is preserved, but if it is not checked, files will be renamed to the 
exact case shown in the "To" field.

Pressing the "Auto-text Wizard" button brings up the auto-text wizard. The auto-text wizard 
allows you to control the settings for the automatically generated text that can be inserted 
into the filenames.



Auto-text

Auto-text is automatically generated text that can be inserted into the filenames.    This can 
be one of the following:

    Numbers
    File last-modified time
    File size
    Parent folder name

Auto-text can be inserted into filenames by using the change text panel.    Auto-text 
commands are added to the filename by inserting the auto-text command into the filename 
inside < and > characters.    For example, the auto-text command to insert a number 
starting at 0 and incrementing by 1 for each file is <0>.    Since filenames can not contain 
the characters < or >, there is no problem with using these characters to indicate auto-text 
commands.

However, you never have to enter auto-text commands directly, since there are four auto-
text wizards that let you set the auto-text that you want.    To bring up these wizards, press 
the “Auto-text Wizard” button on the change text panel. 

When you use an auto-text wizard, you have the choice of replacing the current part of the 
filename with the auto-text, or adding the auto-text to the start or end.    This is controlled by
the pop-up menu at the bottom of the auto-text wizards.    This simply controls how the auto-
text command is inserted into the "To" box on the change text panel.    Once you have used 
an auto-text wizard to add an auto-text command, you can then make further changes to 
the text in the "To" box, as long as you don’t edit the text between the < and > characters 
(which is the auto-text command itself).



Shows the text for the part of the filename being changed by this control.    This field is read-
only.    If the case (upper or lower) of this part of all the filenames is the same, then this case 
will be shown in the "From field".    If the case is different for some filenames, then the case 
shown will be lower case.



Enter the text to rename this part of the filename to in the "To" field.    Entering text in this 
field automatically unchecks the "Leave unchanged" switch.



Check this box to leave this part of the filenames unchanged.    If it is not checked, then this 
part of the filenames is changed to the text shown in the "To" field.    Note that even if the 
text in the "To" field is the same as the text in the "From" field, then this may still result in a 
filename being changed, since the case of some of the characters may be different.



Press this button to bring up the auto-text panel.



Change Number panel

The Change Number rename control is used for numbers embedded in the filenames.    This 
control is only used if the treat numbers as text option is off.    It is shown like this:

The change number panel is brought up by clicking in the change number box:

This panel allows leading zeros to be added to or removed from the number, and an offset to
be added to the number.

Adding leading zeros
If the "Add" switch is checked, then this part of the name will be changed so that the 
number has at least the number of digits entered in the "digits" field.    For example, to 
change 42 into a 4 digit number, it is renamed to 0042.    If the number already has more 
digits than that shown, it is left unchanged.

When leading zeros are being added to the number, this is shown in the change number box
by adding a small "0" in the lower left corner, and the number of digits in the upper left 
corner like this:

Removing leading zeros
If the "Remove" switch is checked, then any leading zeros in the number will be removed.    
This is shown in the change number box by adding a small "-0" in the lower corner like this:



Adding an offset
An offset can be added to the number by entering an offset into the "Add offset" field.    An 
offset of 0 leaves the number unchanged.    The offset can be positive or negative, but if the 
number generated for any filename falls below 0, it will be set to 0.    Negative numbers can 
not be generated for filenames.    The offset is shown in the change number box in the lower 
right corner like this:

Clear number
If the “Clear number” box is checked, then the number will be removed from the filename.    
In this case, the other controls on the panel are disabled since they have no effect.



Select this option to leave the number of digits in this number unchanged (unless it needs to
be increased due to a large offset being added).



Select this option to add leading zeros to this number to make its length equal to that shown
in the "digits" field.    If the number already has this many digits or more, then it is left 
unchanged.



Select this option to remove any leading zeros on this number.



The "digits" field is only enabled if the "Leading zeros, Add" switch is selected.    This field 
specifies the minimum number of digits for this number, which is achieved by adding 
leading zeros if necessary.



Enter a number in this field that will be added to this number in each filename.    The value 
may be positive or negative, but if a negative value is entered and this makes the number 
for a particular filename less than 0, then 0 will be used instead.



Check this box to erase the number from the filenames.



Change Wild panel

The Change Wild rename control is used for parts of the name that are not the same in all 
filenames.    It is shown like this:

The change wild panel is brought up by clicking in the change wild text box:

This panel allows the case of this part of the name to be changed, or the name to be 
shortened.    By default, this part of the name is left unchanged.

Changing the case
The case of this part of the name can be made upper or lower case by selecting the 
appropriate switch.    If it is made upper case, the wild card rename control is shown with a 
small U like this:

If it is made lower case, the wild card rename control is shown with a small L like this:

Find & Replace



If any text is entered in the "Replace" box, then all occurrences of that text in this part of the
name are replaced with the text in the "With" box.    If no text is entered in the "Replace" 
box, then the "With" box is disabled.

Although this Find and Replace operation offers similar functionality to simply entering the 
text to be replaced in the selector (surrounded by * wildcards), there are subtle differences.   
Firstly, this Find & Replace operation replaces all occurrences of the text, whereas using the 
selector would only replace the first occurrence.    Secondly, this Find & Replace operation 
does a case-sensitive search for text to replace, whereas the selector is case insensitive.

This Find & Replace operation is particularly useful for single character operations, such as 
removing spaces from filenames, or replacing spaces by underscores.

Shortening the name
If the “Truncate“ switch is checked, then this part of the name will be truncated to the 
number of characters shown in the "Maximum Length" field.    If this part of the name is 
already shorter than this limit for any particular file, then it is left unchanged.    When the 
wild part of the name is being truncated, it is shown by adding the maximum length to the 
wild card rename control like this:



This "Leave unchanged" case option means that for the part of the filename matched with 
this wild card, the case will be left unchanged. 



This "Make upper case" option means that the part of the filename matched with this wild 
card will be renamed to be all upper case.



This "Make lower case" option means that the part of the filename matched with this wild 
card will be renamed to be all lower case.



All occurrences of the text entered in this box that can be found in the part of the filename 
matched with this wild card will be replaced by the text in the "With" box.    If this box is 
empty, then no find and replace is performed.    Note that the text entered in this box is case 
sensitive.



The text in this box replaces all occurrences of the text in the "Replace" box that can be 
found in the part of the filename matched with this wild card.    This box is only enabled if 
one or more characters to find have been entered in the "Replace" box.



Check this box to truncate the part of the filename matched with this wild card so that it has
at most the number of characters shown in the "Maximum length" field.    If it is not longer, it
is left unchanged.



Shows the maximum length for the part of the filename matched by this wild card. If it is 
longer than this length, it is truncated, otherwise it is left unchanged. This field is only 
enabled if the "Truncate" switch is checked.



Auto-number wizard

The auto-number wizard is one of the auto-text wizards.    It is brought up by pressing the 
Auto-text Wizard button on the change text panel, and selecting the Auto-number tab.

This auto-text wizard allows you to add numbers to a filename.    The start value and step 
can be set.    The numbers are set in the filenames in the order that the files are listed in the 
file list.    The files in the file list can be sorted either by the name, or by the file size or last-
modified time.    The column headers in the file list show the sort order, since the column 
that is used for sorting will have a small triangle in it.    The sort order can also be reversed 
by clicking on the same column header again.    The direction of the triangle shows whether 
the sort order is ascending or descending.    In order to sort on file size or last-modified time, 
the appropriate column will need to be shown in the file list.    These columns can be added 
or removed from the View menu.

Setting the start and step values
The "Start" number is the first number that will be generated.    Floating point numbers are 
not supported, and negative values can not be generated for filenames.    The "Step" value 
must also be positive.    If you want to auto-number the files in the opposite direction, simply 
reverse the sort order by clicking on the sort column header in the file list.

Setting the leading zeros
To have leading zeros for the generated numbers, simply check the "Leading Zeros Add" 
switch, and enter the number of digits required.    Note: if the number already has more 
digits than this, it is left unchanged, it will not be shortened.



Enter the starting number to be generated into this field.    This value may not be negative.    
If you enter a value less than 0, it will be replaced by 0.



Enter the step value into this field.    This value will be successively added to the start value 
to generate the number sequence.    The step value may be positive or negative, but if the 
number generated falls below 0, then it will be clipped to 0.



Select this option to add leading zeros to the number generated to make its length equal to 
that shown in the "digits" field.    If the number already has this many digits or more, then it 
is left unchanged.



This field specifies the minimum number of digits for the number generated, which is 
achieved by adding leading zeros if necessary. This field is only enabled if the adjacent box 
is checked.



This menu selects how the auto-text is added to the "To" box in the Change Text panel.    It 
can either replace any text already in the "To" box, or be added to the start or end.    If the 
"To" box is empty, then this menu has no effect.



File Time Auto-text wizard

The file time wizard is one of the auto-text wizards.    It is brought up by pressing the Auto-
text Wizard button on the change text panel, and selecting the File Time tab.

This auto-text wizard allows you to add the file last-modified time to a filename.    The time 
can be added in any of the formats shown in the list.



Select the format you want for the modified time of the file.



File Size Auto-text wizard

The file size wizard is one of the auto-text wizards.    It is brought up by pressing the Auto-
text Wizard button on the change text panel, and selecting the File Size tab.

This auto-text wizard allows you to add the file size to a filename.    The size can be entered 
in any of the following units:

    bytes
    kilobytes (1 KB = 1024 bytes)
    megabytes (1 MB = 1024 KB)
    gigabytes (1 GB = 1024 MB)
    auto

If auto is selected, then the size will be shown in the largest units possible, i.e. gigabytes if 
the file size is 1GB or greater, or megabytes if 1MB or greater, or kilobytes if 1KB or greater, 
otherwise bytes.    In auto mode, the units are shown by adding B if the units are bytes, K for 
kilobytes, M for megabytes or G for gigabytes.    In all other modes the size is only shown as 
a number, since there is no ambiguity.    If you did want to show the units, it can be added 
like any other text after the auto-text command.

When any units except bytes is selected, the size will always be rounded up to the next 
whole number.



Check this to add the file size in bytes.



Check this to add the file size in kilobytes (1 KB = 1024 bytes).



Check this to add the file size in megabytes (1 MB = 1024 KB).



Check this to add the file size in gigabytes (1 GB = 1024 MB).



Check this to add the file size in units that are automatically determined.    The units are 
bytes up to a size of 1 KB, then KB up to 1 MB, then MB up to 1GB, then GB.    B, K, M or G is 
added to show which units are being used.



Folder Name Auto-text wizard

The folder name wizard is one of the auto-text wizards.    It is brought up by pressing the 
Auto-text Wizard button on the change text panel, and selecting the Folder Name tab.

This auto-text wizard allows you to add the parent folder name to a filename.



General Options panel

The general options panel is brought up by selecting the options command from the view 
menu.

This panel allows you to set the following options:

Auto-select all when folder selected
If this box is checked, then every time a folder is selected in the folder browser, an auto-
select will automatically be run for all of the files in that folder.    This is the same as if you 
press the auto-select all button each time you select a new folder.    This is useful if you want
to rename files differently in different folders.    However, if you want to use the same 
rename command in lots of folders, or if you tend to mainly use stored command, then you 
should turn this option off.

Recent folders list size
Each time a folder is selected it is added to the recent folders list, which can be found in the 
Recent Folders submenu of the file menu.    This option allows you to change how many 
folders are kept in the recent folders list.    Note that when this value is changed, it will only 
take effect the next time you run RenameMan.



Check this box to do an auto-select all whenever a folder is selected.



Enter the number of recently selected folders to keep in the Recent Folders list.    Note: 
changing this value will only take effect the next time you run RenameMan.



Column Options panel

The column options panel is brought up by selecting the options command from the view 
menu, and then pressing the "Columns" tab.    

This panel allows you to select which of the optional columns appear in the file list.    

File Size
If this box is checked, then a column showing the size of each file in the file list is added.

Modified Time
If this box is checked, then a column showing the last modified time of each file is shown in 
the file list.

These additional columns can be useful when using the auto-number command, since they 
allow the list to be sort by file size or modified time.

An alternative way to show or hide these columns is to right click in the column header in 
the file list, and select the column name from the pop-up menu.



Check this box to add a file size column to the file list.



Check this box to add a modified time column to the file list.



Auto Select panel

This panel can appear during the auto-select operation.    Normally, the auto-select operation
is very fast, but in exceptional circumstances it can take a while to complete.    This panel 
allows you to cancel a slow auto-select operation, rather than waiting for it to complete.



Rename panel

This panel can appear while renaming files.    If you are renaming a lot of files, this can take 
some time.    This panel allows you to cancel a rename operation, rather than waiting for it to
complete.    Note that if you cancel a rename operation, then some of the files you selected 
will have been renamed, and others will not.



No folder selected

Before you can rename any files, you must select the folder that contains the files you want 
to rename.    Use the folder browser to select the folder, then use the rename controls to set 
up a rename command.



Rename error

This message indicates that there is a problem with the rename command you are 
attempting to perform.    The files that are causing the problem will be indicated in the file 
list.    You must resolve this problem before you can rename any files, either by excluding the
files that have the problem, or by changing the rename command.



No files to rename

This message indicates that you pressed the rename button when there were no files to be 
renamed.    Files that are selected to be renamed will appear in the file list.    If this list is 
empty, then either the current folder is empty, or the selector does not match any files in 
the current folder, or all the files have been excluded.



No changes

This message indicates that you pressed the rename button, but none of the files in the file 
list are set to be changed.    Use the rename control boxes to set the rename command.



Failed to rename file

This message indicates that the given file could not be renamed for the reason given.    Press
OK to carry on renaming the rest of the files, or Cancel to stop renaming.    Note that if you 
press Cancel, the files that have already been renamed will stay renamed.



Failed to rename file

This message indicates that the file could not be renamed for the reason given.    Correct the
problem and try again.



No name entered

You have not entered a new name to rename the file to.    All files must have a name of at 
least one character in length.



Welcome to RenameMan

The code you have entered has been verified, so your version of RenameMan is now 
registered.    This means that none of the panels referring to the evaluation period will 
appear from now on.

We hope you continue to find RenameMan to be a valuable tool.

Thank you for registering RenameMan.



Incorrect code

The code you have entered is invalid.    Check that you have entered the code exactly as 
given.

If you do not have a registration code, you can get one by ordering RenameMan.



Extended evaluation

The code you have entered has granted you an extended evaluation period.    Note that this 
code can only be used once!



Evaluation extension already used

You have already entered the code to extend your evaluation period, and it can only be used
once.

The only way to activate RenameMan now, is to order it for just $15.    You will then be sent 
the full registration code.

Thank you for trying RenameMan.



Evaluation extension already used

You have already entered the code to extend your evaluation period, and it can only be used
once. 



Invalid filename

Filenames can not contain any of these characters:
\ / : * ? " < > |

This is a restriction built into Microsoft Windows, so RenameMan does not allow you to try to 
rename files to a name that contains one of these characters.



Invalid filename

Filenames can not contain the > character. This is a restriction built into Microsoft Windows, 
so RenameMan does not allow you to try to rename files to a name that contains this 
character.

The only time this character is allowed is when it is part of an auto-text command.    If you 
have accidentally edited an auto-text command to make it invalid, run the auto-text wizard 
again.    



Invalid filename

Filenames can not contain the < character. This is a restriction built into Microsoft Windows, 
so RenameMan does not allow you to try to rename files to a name that contains this 
character.

The only time this character is allowed is when it is part of an auto-text command.    If you 
have accidentally edited an auto-text command to make it invalid, run the auto-text wizard 
again.    



Duplicate command name

Each stored command must have a different name.    This error panel appears if you try to 
set the name of a stored command to the same name as an existing stored command.

The name of a stored command is shown in the stored commands list, so try to make it 
descriptive so you can remember what the rename command does.



No command name

Stored commands must be given a name that contains at least one character.

The name of a stored command is shown in the stored commands list, so try to make it 
descriptive so you can remember what the rename command does.



Failed to read the default commands

This panel appears if there is a problem reading the default commands from the default 
commands file.    The default commands are the commands that are restored when the Reset
button is pressed on the stored commands panel.    This file should have been copied to the 
installation folder when RenameMan was installed.

To fix this problem, either
1. Re-install RenameMan, which should restore the original default commands that come 

with RenameMan.
1. Set up the commands you want to make the default stored commands, and then press 

the Set button.



Failed to write the default commands

This panel appears if there is a problem writing to the default commands file. The default 
commands are the commands that are restored when the Reset button is pressed on the 
stored commands panel.






